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Introduction 

Overview 
Grid Master is a sophisticated grid trading bot developed for the NinjaTrader platform, designed to 
automate trading decisions based on pre-configured grid structures. The bot strategically places 
buy and sell orders at various price levels, known as “grid levels,” which allows for eƯective trading 
in markets with sideways movement, fluctuations, or clear price patterns. By leveraging grid trading 
strategies, Grid Master enables traders to capitalize on price movements without needing to predict 
market direction. 

Grid Master is customizable and can be tailored to specific instruments, trading sessions, risk 
parameters, and market conditions, making it a versatile tool for both novice and experienced 
traders. With real-time updates and the ability to manage multiple grids simultaneously, Grid 
Master provides a powerful solution for traders seeking automated execution with built-in risk 
management. 

Key Features 
 Automated Grid Creation: Automatically generate and manage multiple grid levels based 

on user-defined parameters such as tick size, trade size, and risk management limits. 

 Real-Time Adjustments: Modify grid parameters, such as trade size and grid levels, in real-
time using the GridMaster200 API. 

 Customizable Risk Management: Set upper and lower price limits, profit and loss shutoƯ 
levels, and max entry points to control risk exposure. 

 Trailing Options: Utilize trailing entries and targets to adapt to dynamic market movements. 

 Grid Wizard: An AI-powered tool that analyzes historical data to recommend optimized grid 
settings based on your trading profile and market conditions. 

 Seamless Integration with NinjaTrader: Leverages NinjaTrader’s robust API for smooth 
execution and real-time performance tracking. 

System Requirements 
To run Grid Master, ensure you meet the following system requirements: 

 NinjaTrader Platform: Version 8.0 or later. 

 Operating System: Windows 7 or newer (64-bit), or equivalent virtual machine setup. 

 Internet Connection: A stable and fast internet connection is recommended for optimal 
performance. 
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Installation and Setup 

Prerequisites 
Before you can use Grid Master, ensure that: 

 You have NinjaTrader 8.0 or later installed on your system. 

 You have an active NinjaTrader account with API access enabled. 

 You have received the Grid Master software as a ZIP file via email. 

Installation Instructions 
Once you have purchased Grid Master and received the ZIP file, follow these steps to install it into 
your NinjaTrader platform: 

1. Save the ZIP File: Download the ZIP file attached to the email and save it to a location on 
your computer. Do not extract or unzip the file. 

2. Open NinjaTrader: Launch the NinjaTrader 8 platform and log in to your account. 

3. Access the Import Feature: 

o From the NinjaTrader control center, click on Tools from the menu at the top. 

o Select Import and then click on NinjaScript Add-On.... 

4. Import the Grid Master ZIP File: 

o In the import window that opens, navigate to the location where you saved the ZIP 
file. 

o Select the ZIP file and click Open. 

o NinjaTrader will now import the Grid Master software. You may receive a 
confirmation message once the import is successful. 

5. Restart NinjaTrader: After the installation, it's recommended to restart NinjaTrader to 
ensure all settings and files are properly loaded. 

Initial Setup and Launch 
Once Grid Master is installed, you can launch and configure it as follows: 

1. Open Grid Master: 

o From the NinjaTrader control center, go to the menu bar and click on New. 

o In the dropdown menu, select Grid Master 200. 

o The Grid Master window will open, allowing you to start configuring your grid trading 
strategy. 
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2. Basic Configuration: 

o To create a new grid go to File→New→GridWidzard or File→New→Custom Grid 

o Upon opening the Grid Master window, you’ll be presented with options to configure 
various grid parameters such as instrument, trade size, and risk settings. Detailed 
instructions for these parameters are provided in the MyGrid Parameters section of 
this document. 

o For each grid the button under “Action” is a toggle that will Enable and Disable that 
specific grid. 

o The “Close” button will close all positions on the specific grid, cancel any working 
orders and disable the algorithm for that grid. 

o To permanently delete a grid left click on the grid and press the delete button.  
NOTE: this is PERMANENT and CAN NOT BE UNDONE!!  You may want to consider 
saving the grid before it is deleted from the Grid Master 200 control window. 

3. Saving Your Setup: 

o Once your configuration is complete, you can save the settings to be reused in 
future sessions. Grid Master will automatically save your grids and settings unless 
otherwise specified. 

o You can manually save the grid by using File→Export Grid.  When you name the file it 
is suggested you put the word “grid” in the filename so it will not be confused with a 
saved workspace file. 

o You can manually save the workspace by using File→Workspace→Save.  It is also 
recommended that you put the word “workspace” in the file name so it will not be 
confused with a saved grid file. 

o LTC does recommend that you backup your grids and workspaces after the first 
working creation and after any significant change. 

Configuration Overview 
Grid Master oƯers a wide range of customizable parameters to suit your trading style and market 
conditions. Before proceeding with live trading, it’s recommended that you: 

 Run in Simulated Mode: Test your configuration in NinjaTrader’s simulation mode (Sim101 
account) to ensure your settings are performing as expected. 

 Review Key Parameters: Pay close attention to grid levels, trade size, risk limits, and trailing 
settings to ensure they align with your risk management strategy. 
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MyGrid Parameters 
Grid Master allows users to configure various parameters for their grid trading strategy, enabling 
fine control over how orders are placed and managed in response to market movements. Below are 
the key MyGrid parameters, with explanations of their roles and how they influence the behavior of 
the grid. 

1. Name 

 Description: A custom name for the grid instance. This helps identify diƯerent grids when 
multiple grids are active. 

 Default Value: {SelectedAccount} - Unnamed. 

 Example Use Case: Naming grids after specific strategies, such as "S&P 500 Long Grid" or 
"Crude Oil Range Grid." 

2. SelectedAccount 

 Description: The trading account to be used by the grid. This can be set to any of your 
available accounts in NinjaTrader (e.g., Sim101 for simulation, or a live trading account). 

 Default Value: Sim101. 

 Example Use Case: Use a simulation account to test new grid settings before deploying to 
a live account. 

 

3. SelectedInstrument 

 Description: The financial instrument the grid will trade (e.g., Forex pair, stock, futures 
contract). The instrument defines the market and its tick size, which will impact grid levels. 

 Example Use Case: Setting the grid to trade EUR/USD or E-mini S&P 500 futures. 

4. TradeSide 

 Description: Determines the direction of trades the grid will make. Options include: 

o Long: Only buy trades will be placed. 

o Short: Only sell short trades will be placed. 

o Both: Buy and sell trades will be placed depending on market movement. 

 Default Value: Both. 

5. TradeSize 

 Description: The number of units/contracts for each trade. 

 Example Use Case: Setting TradeSize to 1 for testing in small quantities, or adjusting based 
on market volatility. 
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6. LevelTicks 

 Description: The distance (in ticks) between two grid levels. This defines how far apart the 
buy and sell orders are placed along the price scale. 

 Example Use Case: In a highly volatile market, you may set LevelTicks higher to space out 
the grid, capturing larger price movements. 

7. TicksToSkip 

 Description: The number of ticks to skip between grid levels to avoid placing too many 
orders in close proximity. 

 Example Use Case: Adjusting TicksToSkip to a value that helps minimize unnecessary 
trades in choppy markets. 

8. MaxEntries 

 Description: The maximum number of grid levels (or entries) that can be active at once. 
This sets an upper limit to how many positions the bot will open. 

 Example Use Case: Setting MaxEntries to control the exposure of the strategy. For example, 
limiting to 5 entries in volatile markets to manage risk. 

9. Risk To Max 

 ???? 

10. Trailing Entries / Trailing Targets 

 Description: These parameters enable the grid to trail the market, adjusting entry and 
target levels as the market moves. 

 Example Use Case: Activating Trailing Entries / Trailing Targets to follow a trend, ensuring 
new trades are placed at increasingly favorable prices. 

 

11. Start Price 

 Description: The price level at which the grid begins to place buy and sell orders. If the 
market reaches this price, the grid starts working. 

 Example Use Case: Starting the grid at a specific price based on recent support or 
resistance levels. 

12. UpperLimit / LowerLimit 

 Description: The upper and lower bounds where the grid will stop executing trades. If the 
market price goes beyond these levels, no further trades will be placed. 

 Example Use Case: Using UpperLimit and LowerLimit to define a trading range, shutting oƯ 
trades if the market exceeds this range to prevent unnecessary exposure. 
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13. ProfitShutoƯ / LossShutoƯ 

 Description: These are profit and loss thresholds that, when reached, will stop the grid 
from executing further trades. 

 Example Use Case: Setting a ProfitShutoƯ to lock in gains after a certain amount of profit is 
realized or using LossShutoƯ to minimize potential losses. 

14. Trail Stop 

 ???? 

15. StopWhenFlat 

 Description: When enabled, this stops the grid from placing new trades once all open 
positions have been closed and the market position is flat. 

 Example Use Case: Useful for closing out a strategy after a certain time or profit level is 
reached, avoiding additional trades. 

16. StartTime / StopTime 

 Description: Defines the time window during which the grid is active. Trades will only be 
placed between the StartTime and StopTime. 

 Example Use Case: Setting a grid to only trade during the regular trading session (e.g., for 
(9:30 AM to 4:00 PM you would enter 093000 and 160000 – HHMMSS, no colons, no 
slashes, 24 hour time). 

 

 

 

?.StartZone 

 Description: Defines the percentage of grid orders that are placed as breakout orders 
(stop-limit) versus pullback orders (limit). A higher percentage means more breakout 
orders, while the remainder are pullback orders. 

 Example Use Case: Setting StartZone to 60% for the S&P 500 E-mini Futures places 60% of 
orders as breakout trades and 40% as pullback trades, capturing both upward breakouts 
and potential pullbacks in a volatile market. 

 

You can refer to the diagram below for a visual representation of how some of these parameters 
(like LevelTicks, TicksToSkip, and MaxEntries) function in a grid trading strategy: 

In this diagram: 
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 LevelTicks defines the vertical distance between each blue line, representing a price level 
where a trade is placed. 

 TicksToSkip indicates the skipped price levels between trades to avoid overly tight orders. 

 MaxEntries sets a cap on how many levels (trades) can be active at once. 
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GridMaster200 Class API Documentation 

Overview 
The GridMaster200 class is the core API used to manage grid trading operations within the Grid 
Master bot. It provides methods for creating, updating, enabling, and disabling grids, as well as 
adjusting specific grid parameters programmatically. These methods allow for dynamic interaction 
with the grid structure, providing flexibility to adapt grid behavior based on market conditions or 
user preferences. 

Required Namespaces 
Ensure the following namespace is included at the top of your file: 

using NinjaTrader.NinjaScript.AddOns.MooreTechLLC; 

 
Class: GridMaster200 
1. CreateGrid 

 Description: Adds a new grid to the Grid Master system. This method takes a MyGrid object 
as input and initializes it within the grid trading strategy. 

 Parameters: 

o grid: A MyGrid object that contains the grid's configuration settings. 

 Throws: 

o InvalidOperationException: If the GridMaster200 window or view model is not found. 

o ArgumentNullException: If the provided grid object is null. 

Example Usage: 

var myGrid = new MyGrid 
{ 
    Name = "S&P 500 Grid", 
    SelectedAccount = "Sim101", 
    SelectedInstrument = Instrument.GetInstrument("ES 03-24"), 
    TradeSide = TradeSide.Both, 
    TradeSize = 1, 
    LevelTicks = 10, 
    TicksToSkip = -5, 
    MaxEntries = 5, 
    StartPrice = 4500, 
    UpperLimit = 4600, 
    LowerLimit = 4400, 
    ProfitShutoff = 1000, 
    LossShutoff = 500, 
    StartTime = 93000, 
    StopTime = 160000, 



Grid Master 
 

Page 10 of 29 
 

    TrailingEntries = true, 
    TrailingTargets = true, 
    StopWhenFlat = false 
}; 
GridMaster200.CreateGrid(myGrid); 

 
2. RemoveGrid 

 Description: Removes an existing grid by its name. This method searches for the grid by the 
name provided and removes it from the active grids list. 

 Parameters: 

o name: The name of the grid to be removed. 

 Throws: 

o InvalidOperationException: If the GridMaster200 window or view model is not found. 

Example Usage: 

GridMaster200.RemoveGrid("S&P 500 Grid"); 
 

3. UpdateStartTime 

 Description: Updates the start time of an existing grid. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

o newValue: The new start time (formatted as HHMMSS). 

Example Usage: 

GridMaster200.UpdateStartTime(indicator, "S&P 500 Grid", 83000); 
 

4. UpdateStopTime 

 Description: Updates the stop time of an existing grid. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

o newValue: The new stop time (formatted as HHMMSS). 

Example Usage: 

GridMaster200.UpdateStopTime(indicator, "S&P 500 Grid", 160000); 
 
5. UpdateLevelTicks 



Grid Master 
 

Page 11 of 29 
 

 Description: Updates the number of ticks between grid levels. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

o newValue: The new number of ticks between levels. 

Example Usage: 

GridMaster200.UpdateLevelTicks(indicator, "S&P 500 Grid", 15); 
 

6. UpdateTradeSize 

 Description: Updates the trade size for an existing grid. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

o newValue: The new trade size. 

Example Usage: 

GridMaster200.UpdateTradeSize(indicator, "S&P 500 Grid", 2); 
 

7. UpdateUpperLimit 

 Description: Updates the upper limit of a grid. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

o newValue: The new upper limit price. 

Example Usage: 

GridMaster200.UpdateUpperLimit(indicator, "S&P 500 Grid", 4650.0); 
 
8. UpdateLowerLimit 

 Description: Updates the lower limit of a grid. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 
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o newValue: The new lower limit price. 

Example Usage: 

GridMaster200.UpdateLowerLimit(indicator, "S&P 500 Grid", 4350.0); 
 
9. Enable 

 Description: Enables the specified grid, allowing it to start placing trades. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

Example Usage: 

GridMaster200.Enable(indicator, "S&P 500 Grid"); 
 
10. CloseAndDisable 

 Description: Closes all open positions associated with the grid and disables the grid to 
prevent further trades. 

 Parameters: 

o i: The indicator associated with the grid. 

o name: The name of the grid. 

Example Usage: 

GridMaster200.CloseAndDisable(indicator, "S&P 500 Grid"); 
 

Example: Creating and Managing a MyGrid Object 

Here’s a complete example of creating a MyGrid object, adding it to the grid system, updating 
parameters, and then enabling it.  

 

// Step 1: Create a new grid object 
var myGrid = new MyGrid 
{ 
    Name = "Crude Oil Grid", 
    SelectedAccount = "Sim101", 
    SelectedInstrument = Instrument.GetInstrument("CL 02-24"), 
    TradeSide = TradeSide.Both, 
    TradeSize = 1, 
    LevelTicks = 20, 
    TicksToSkip = -10, 
    MaxEntries = 6, 
    StartPrice = 70.50, 
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    UpperLimit = 75.00, 
    LowerLimit = 65.00, 
    ProfitShutoff = 500.0, 
    LossShutoff = 200.0, 
    StartTime = 90000, 
    StopTime = 153000, 
    TrailingEntries = true, 
    TrailingTargets = false, 
    StopWhenFlat = true 

}; 
 
// Step 2: Add the grid to the system 
GridMaster200.CreateGrid(myGrid); 
 
// Step 3: Update grid parameters dynamically 
GridMaster200.UpdateTradeSize(indicator, "Crude Oil Grid", 2); 
GridMaster200.UpdateUpperLimit(indicator, "Crude Oil Grid", 76.00); 
 
// Step 4: Enable the grid to start trading 
GridMaster200.Enable(indicator, "Crude Oil Grid"); 
 
// Step 5: Close all positions and disable the grid when finished 
GridMaster200.CloseAndDisable(indicator, "Crude Oil Grid"); 
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Advanced Features 
Grid Master comes with several advanced features that provide flexibility, adaptability, and 
enhanced control over grid trading strategies. These features allow traders to optimize their grid 
configurations for diƯerent market conditions and trading preferences, making the bot versatile for 
both trending and ranging markets. 

1. Grid Wizard 

The Grid Wizard is a tool built into Grid Master that assists traders in setting up grids by analyzing 
historical market data. It oƯers recommendations for grid parameters based on the selected 
instrument's price action, volatility, and trading session patterns. 

 How It Works: The wizard analyzes the selected instrument over a user-defined time range. 
It examines price volatility, support and resistance levels, and historical ranges to suggest 
optimal values for LevelTicks, TicksToSkip, MaxEntries, and StartPrice. 

 Example Use Case: A trader who is unfamiliar with a new instrument can use the Grid 
Wizard to quickly generate a base set of grid parameters for backtesting before going live. 

 Customization: While the wizard provides recommendations, traders can override any of 
the parameters to suit their personal strategy. 

2. Trailing Entries 

Trailing Entries is a feature that allows grid levels to automatically adjust in response to market 
movements. This is particularly useful in trending markets, where the grid can follow the price and 
update its entry points dynamically. 

 How It Works: When TrailingEntries is enabled, Grid Master will move the entry levels of the 
grid upward in a rising market or downward in a falling market. As the price moves further 
away from the grid’s initial setup, the grid adjusts, maintaining a predefined gap between 
entry levels and the current price. 

 Example Use Case: In a bullish market, a trader may enable TrailingEntries so that the grid 
entries follow the price upward, capturing opportunities at progressively higher price levels. 

 Configuration: Traders can configure the trailing sensitivity, determining how closely the 
grid follows the market movements. 

3. Trailing Targets 

Similar to trailing entries, Trailing Targets allows the profit targets of existing positions to move in 
sync with the market. 

 How It Works: When TrailingTargets is enabled, Grid Master adjusts the take-profit levels to 
reflect the direction of market movement. This allows traders to capture more profit during 
sustained trends. 
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 Example Use Case: In a strong bullish trend, enabling TrailingTargets will allow the trader to 
capture higher profits as the price rises. The bot adjusts the profit levels upward, giving 
positions more room to run. 

 Best Practice: Trailing Targets should be used in trending markets to maximize profit 
potential without manually adjusting the grid after each price movement. 

4. Time-Based Control 

Grid Master oƯers Time-Based Control features that allow traders to define active trading periods 
within the day. 

 StartTime and StopTime: Traders can specify when the grid should start and stop trading, 
using 24-hour time format. For example, a trader may want the grid to be active only during 
regular market hours (e.g., from 09:30 AM to 04:00 PM). 

 Example Use Case: A trader might configure the grid to start at the market open, execute 
trades throughout the day, and stop at market close, avoiding overnight trading when 
volatility may be unpredictable. 

5. Profit and Loss ShutoƯ 

Grid Master includes ProfitShutoƯ and LossShutoƯ mechanisms that automatically stop the grid 
from placing further trades once a certain profit or loss threshold is reached. 

 ProfitShutoƯ: When this parameter is set, the grid will stop placing new trades once a 
defined profit level (in currency or ticks) is achieved. This helps lock in gains without 
overexposing the account to further market movements. 

 LossShutoƯ: Similarly, the grid will cease trading if the loss reaches a certain threshold. 
This prevents a grid from incurring further losses during adverse market conditions. 

 Example Use Case: A trader sets ProfitShutoƯ to 1000 (in currency) and LossShutoƯ to -
500. If the grid reaches a cumulative profit of $1000, it will stop trading for the rest of the 
day. If it reaches a loss of $500, it will also stop to prevent further drawdowns. 

6. Real-Time Parameter Adjustments 

Grid Master supports Real-Time Parameter Adjustments, allowing traders to modify grid settings 
while the bot is live and actively trading. 

 Parameters That Can Be Adjusted: Traders can update grid parameters such as 
LevelTicks, TradeSize, UpperLimit, LowerLimit, StartPrice, and time settings without 
stopping the grid. 

 How It Works: Changes are applied immediately to the running grid, allowing it to adjust its 
future trades based on the updated settings. 

 Example Use Case: A trader monitoring a live grid during a sudden volatility spike might 
increase LevelTicks and MaxEntries to take advantage of larger price swings, updating the 
settings without needing to disable the grid. 
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7. Grid Range Management 

UpperLimit and LowerLimit parameters allow traders to define a price range for the grid to operate 
within. No new trades are placed if the market price exceeds these limits. 

 Example Use Case: A trader sets an UpperLimit of $4600 and a LowerLimit of $4400 for the 
S&P 500 grid. If the price moves outside of this range, the grid will stop placing trades until 
the market re-enters the defined range. 

 Best Practice: Use these limits to protect against significant market moves that could 
result in large losses or highly unfavorable trades. 

8. Backtesting and Optimization 

Grid Master integrates with NinjaTrader's Strategy Analyzer to support Backtesting and 
Optimization of grid configurations. 

 Backtesting: Traders can simulate the performance of their grid strategy using historical 
data. This allows them to evaluate the grid's performance under diƯerent market conditions 
before going live. 

 Optimization: The Optimization tool can automatically tweak grid parameters to find the 
optimal settings for maximizing profit, minimizing risk, or balancing both. Parameters such 
as TradeSize, LevelTicks, and MaxEntries can be optimized to fit a specific instrument or 
time frame. 
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Troubleshooting and FAQs 

Troubleshooting Common Issues 
1. Grid Not Placing Trades 

 Symptom: The grid is not executing any trades, even though the market is moving through 
grid levels. 

 Potential Causes and Solutions: 

1. Account Selection: Ensure that the correct account is selected (e.g., Sim101 for 
simulation or a live account). Check the SelectedAccount parameter in the grid 
configuration. 

2. Market Session Timing: Verify that the grid is running within the active market 
session times. The grid will not place trades outside the defined StartTime and 
StopTime. 

3. Grid Limits: Check if the market price is within the UpperLimit and LowerLimit 
boundaries. If the market is outside these limits, the grid will not execute trades. 

4. Trade Size: Ensure that the TradeSize is greater than zero. 

5. Enabled Status: Make sure the grid has been enabled using 
GridMaster200.Enable(). If the grid is not enabled, it will not place trades. 

2. Trades Exceeding Risk Parameters 

 Symptom: The grid is executing trades beyond the specified risk limits. 

 Potential Causes and Solutions: 

1. ProfitShutoƯ/LossShutoƯ: Verify that the ProfitShutoƯ and LossShutoƯ 
parameters are properly set. If these limits are not configured, the grid may continue 
trading even after exceeding acceptable risk thresholds. 

2. MaxEntries: If too many positions are being opened, review the MaxEntries 
parameter. Setting this value too high may lead to overexposure in volatile markets. 

3. Trailing Stops Not Working 

 Symptom: The grid’s trailing entries or targets are not moving in sync with the market. 

 Potential Causes and Solutions: 

1. TrailingEntries/TrailingTargets: Ensure that TrailingEntries and/or TrailingTargets are 
enabled in the grid configuration. If these settings are turned oƯ, the grid will not 
adjust in response to market movements. 

2. Volatility Check: If the market is too volatile, the grid might not be able to adjust the 
levels eƯectively. In such cases, consider increasing LevelTicks or TicksToSkip. 
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4. NinjaTrader Freezing or Crashing 

 Symptom: NinjaTrader becomes unresponsive or crashes when running the Grid Master 
bot. 

 Potential Causes and Solutions: 

1. Resource Overload: Running multiple grids simultaneously, especially on high-
frequency instruments, can overload system resources. Consider reducing the 
number of active grids or closing other NinjaTrader windows to free up memory and 
CPU resources. 

2. Error Logs: Check the NinjaTrader log or output window for error messages that can 
help identify the cause. Errors may point to specific issues like misconfigured grid 
parameters or unsupported instruments. 

3. NinjaTrader Updates: Ensure that your NinjaTrader version is up to date. Older 
versions may contain bugs or incompatibilities that cause freezing issues. 

5. Parameter Changes Not Taking EƯect 

 Symptom: Adjustments to grid parameters (e.g., LevelTicks, TradeSize) are not reflected in 
the grid’s behavior. 

 Potential Causes and Solutions: 

1. Real-Time Adjustments: Remember that some parameters, like StartPrice or 
Upper/Lower Limits, may only apply to new trades and not aƯect already-open 
positions. Restart the grid after making changes for immediate eƯect. 

2. Saving Changes: Ensure that the grid is saved after making changes. If the changes 
aren’t saved, the grid may revert to its previous configuration. 

 

Frequently Asked Questions (FAQs) 

1. What is the best way to configure my grid for diƯerent market conditions? 

 Answer: The best configuration depends on the market you’re trading in. For ranging 
markets, smaller LevelTicks and tighter MaxEntries can capture small price movements. In 
trending markets, consider enabling TrailingEntries and TrailingTargets to follow the trend 
and increase LevelTicks to capture larger moves. 

2. How do I test a grid before going live? 

 Answer: Use NinjaTrader’s Sim101 account to test your grid in simulated trading. 
Additionally, you can backtest your strategy using NinjaTrader’s Strategy Analyzer to 
evaluate its performance using historical data before applying it to a live account. 

3. What should I do if the grid reaches its profit or loss shutoƯ limit? 
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 Answer: If the grid hits the ProfitShutoƯ or LossShutoƯ threshold, it will automatically stop 
placing new trades. You can either reset the grid manually or wait until the next trading 
session (if configured with specific StartTime and StopTime parameters). 

4. Why isn’t my grid trading during certain times of the day? 

 Answer: Check the StartTime and StopTime parameters in your grid setup. These settings 
define the hours during which the grid is active. If the grid is not trading during your desired 
time window, adjust these parameters accordingly. 

5. How many grids can I run simultaneously? 

 Answer: The number of grids you can run simultaneously depends on your system’s 
resources (e.g., CPU and RAM). However, as a best practice, avoid running too many high-
frequency grids simultaneously, as this can overload NinjaTrader and slow down 
performance. If NinjaTrader slows down or crashes, consider reducing the number of active 
grids or optimizing your computer for performance. 

6. Can I change grid parameters while the bot is running? 

 Answer: Yes, many parameters such as TradeSize, LevelTicks, UpperLimit, LowerLimit, and 
MaxEntries can be adjusted in real-time without stopping the grid. Changes will apply to 
future trades, but may not aƯect existing open positions. 

7. How does the grid handle market gaps or flash crashes? 

 Answer: Grid Master is designed to respect UpperLimit and LowerLimit parameters, so no 
trades will be placed if the price gaps beyond these limits. However, in extreme market 
conditions like flash crashes, it is possible for slippage to occur, which could lead to trades 
being executed at less favorable prices. 

8. What should I do if NinjaTrader freezes while running Grid Master? 

 Answer: First, reduce the number of active grids or the frequency of trades to minimize the 
load on NinjaTrader. If the problem persists, check for NinjaTrader updates and review your 
system’s resource usage (CPU and RAM). Consider contacting NinjaTrader support if the 
issue continues after troubleshooting. 

9. How do I handle a market that is outside the grid's configured limits? 

 Answer: If the market moves outside the grid's UpperLimit or LowerLimit, the grid will stop 
placing trades until the market price re-enters the defined range. To adjust for fast-moving 
markets, you can either increase the grid’s limits or consider enabling trailing entries and 
targets to allow the grid to adapt to price movement. 
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Examples and Use Cases 
The following examples demonstrate how to set up and manage grids using Grid Master for diƯerent 
trading scenarios. These use cases cover a range of market conditions, including trending markets, 
range-bound markets, and volatile conditions, showcasing how Grid Master’s customizable 
parameters can be adapted to various strategies. 

Example 1: Basic Grid Setup for a Range-Bound Market 
In this example, we set up a basic grid for a range-bound market, such as EUR/USD in a relatively 
stable trading range. The goal is to capture small price fluctuations within a defined upper and 
lower boundary. 

Grid Setup: 

 Instrument: EUR/USD 

 TradeSide: Both (Buying at lower levels, selling at higher levels) 

 TradeSize: 1 lot per trade 

 LevelTicks: 10 ticks (small fluctuations) 

 TicksToSkip: -5 (tight spacing between trades) 

 MaxEntries: 8 

 StartPrice: 1.1200 

 UpperLimit: 1.1250 (to avoid over-trading at higher prices) 

 LowerLimit: 1.1150 (to stop trading if the market drops too low) 

 ProfitShutoƯ: $500 

 LossShutoƯ: $200 

 StartTime: 090000 

 StopTime: 170000 (active during the European and US sessions) 

Use Case: 

A trader sets up this grid in anticipation of EUR/USD remaining range-bound between 1.1150 and 
1.1250 during the day. The grid captures small price movements by placing alternating buy and sell 
orders as the price fluctuates. Once the price moves outside of the range, the grid stops trading to 
avoid unpredictable moves. 

Example 2: Advanced Grid Setup for a Trending Market 
In this example, we set up a grid for a trending market, such as crude oil during a bullish run. The 
goal is to buy into the trend and trail the market upward while minimizing risk. 
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Grid Setup: 

 Instrument: Crude Oil (CL 02-24) 

 TradeSide: Long (only buying in an upward trend) 

 TradeSize: 2 contracts per trade 

 LevelTicks: 20 ticks (larger spacing between levels to capture significant price moves) 

 TicksToSkip: -10 (providing some room between trades) 

 MaxEntries: 5 (limiting the number of trades in this volatile market) 

 StartPrice: $70.00 

 UpperLimit: $80.00 

 LowerLimit: $68.00 

 ProfitShutoƯ: $1000 (locking in gains) 

 LossShutoƯ: $500 (cutting losses) 

 TrailingEntries: Enabled (allows the grid to move upward with the trend) 

 TrailingTargets: Enabled (allowing take-profit targets to move higher as the market trends) 

Use Case: 

A trader is anticipating a bullish trend in crude oil and wants to capture profits from rising prices. 
They configure the grid to buy into the trend while using TrailingEntries and TrailingTargets to ensure 
the grid follows the price upward. As the market moves up, the grid continues to buy at higher levels 
and adjust take-profit levels. The ProfitShutoƯ and LossShutoƯ parameters manage risk by capping 
potential gains and losses. 

Example 3: Real-Time API Adjustments in a Volatile Market 
This example demonstrates how a trader can adjust a grid dynamically in response to sudden 
market volatility using the GridMaster200 API. The goal is to widen the grid levels and reduce trade 
size to accommodate larger price swings. 

Initial Grid Setup: 

 Instrument: S&P 500 E-mini Futures (ES 03-24) 

 TradeSide: Both 

 TradeSize: 3 contracts per trade 

 LevelTicks: 10 ticks 

 TicksToSkip: -5 

 MaxEntries: 6 
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 StartPrice: 4500.00 

 UpperLimit: 4600.00 

 LowerLimit: 4400.00 

 ProfitShutoƯ: $2000 

 LossShutoƯ: $1000 

 TrailingEntries: Disabled 

 TrailingTargets: Disabled 

Real-Time Adjustments: 

As volatility increases, the trader adjusts the grid in real time to account for larger price swings. 
They use the following API methods to update the grid without stopping it. 

1. Reduce Trade Size: The trader reduces the trade size to limit exposure during high volatility. 
GridMaster200.UpdateTradeSize(indicator, "S&P 500 Grid", 1); 

2. Widen Grid Levels: They increase LevelTicks to 20, allowing the grid to capture larger price 
movements. GridMaster200.UpdateLevelTicks(indicator, "S&P 500 Grid", 20); 

3. Update Limits: The trader expands the trading range by adjusting the upper and lower 
limits. GridMaster200.UpdateUpperLimit(indicator, "S&P 500 Grid", 4700.00); 
GridMaster200.UpdateLowerLimit(indicator, "S&P 500 Grid", 4300.00); 

Use Case: 

The trader is actively managing the grid to adapt to increased market volatility. By reducing the trade 
size, widening the grid levels, and expanding the upper/lower limits, the trader reduces risk while 
still participating in the market. Real-time API adjustments allow them to make these changes 
without stopping the grid, ensuring continuous operation during volatile conditions. 

Example 4: Grid Setup for Overnight Trading 
This example demonstrates how to configure a grid for overnight trading, where a trader may want 
to avoid major market sessions but still capture price fluctuations during less volatile hours. 

Grid Setup: 

 Instrument: Gold Futures (GC 02-24) 

 TradeSide: Both 

 TradeSize: 1 contract per trade 

 LevelTicks: 15 ticks 

 TicksToSkip: -8 

 MaxEntries: 7 
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 StartPrice: $1850.00 

 UpperLimit: $1900.00 

 LowerLimit: $1800.00 

 StartTime: 180000 (6:00 PM) 

 StopTime: 080000 (8:00 AM) 

 ProfitShutoƯ: $800 

 LossShutoƯ: -$300 

Use Case: 

A trader wants to run a grid strategy overnight on gold futures. They configure the grid to be active 
only during the overnight session, starting at 6:00 PM and stopping at 8:00 AM. This allows the 
trader to capture smaller price movements during quieter hours, while the profit and loss shutoƯ 
mechanisms ensure that risk is controlled. 

Example 5: Testing a New Grid in Simulated Mode 
This example outlines how to use NinjaTrader’s Sim101 account to test a new grid before deploying 
it on a live account. 

Grid Setup: 

 Instrument: NASDAQ 100 Futures (NQ 03-24) 

 TradeSide: Both 

 TradeSize: 1 contract per trade 

 LevelTicks: 12 ticks 

 TicksToSkip: -6 

 MaxEntries: 4 

 StartPrice: 15000.00 

 UpperLimit: 15500.00 

 LowerLimit: 14500.00 

 StartTime: 090000 

 StopTime: 160000 

 ProfitShutoƯ: $1000 

 LossShutoƯ: -$500 

Use Case: 



Grid Master 
 

Page 24 of 29 
 

A trader is unsure of how a new grid setup will perform in real-world conditions. They configure the 
grid to run on the Sim101 account, allowing them to observe how it behaves without risking real 
capital. After running the grid in simulated mode for several trading sessions, the trader can review 
performance data and optimize the grid settings before deploying it on a live account. 
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Conclusion 
Grid Master is a powerful and flexible tool designed to automate grid trading strategies on the 
NinjaTrader platform. By leveraging its highly customizable parameters, traders can tailor their grids 
to suit diƯerent market conditions, risk tolerances, and trading styles. Whether operating in a 
trending market, capturing range-bound movements, or responding to high volatility, Grid Master 
provides the control and adaptability needed to execute trades eƯiciently and eƯectively. 

The advanced features, such as trailing entries and targets, real-time parameter adjustments, and 
the ability to set profit and loss shutoƯ thresholds, allow traders to optimize their strategies 
dynamically. With the help of Grid Master’s API and time-based controls, users can easily fine-tune 
their grids without interrupting live trading. 

By following the examples and best practices outlined in this documentation, traders can gain the 
confidence to deploy Grid Master in both simulated and live environments. Regular backtesting and 
grid optimization will help ensure that your strategy remains aligned with current market conditions, 
while built-in risk management features keep exposure under control. 

Next Steps: 

 Experiment with diƯerent grid configurations in simulated mode to understand how each 
parameter aƯects the bot’s behavior. 

 Use the built-in backtesting tools to analyze grid performance across various historical 
market conditions. 

 Regularly review and update grid settings based on market trends, volatility, and personal 
trading objectives. 

 Stay up to date with any future updates and improvements to Grid Master to take full 
advantage of new features. 

Support and Updates: 

If you encounter any issues or need further assistance, refer to the troubleshooting and FAQ section 
in this documentation or contact our support team. Updates to Grid Master, including new features 
and enhancements, will be provided regularly, ensuring that your trading strategy remains robust 
and adaptable to evolving markets. 
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Appendices 

Appendix A: Glossary of Terms 
 Grid Trading: A trading strategy that involves placing buy and sell orders at predefined 

intervals (grid levels) above and below a set price, allowing traders to profit from market 
fluctuations without predicting the direction. 

 Grid Levels: Predefined price points where buy and sell orders are placed. Each level 
represents an entry or exit point for the strategy. 

 Ticks: The smallest possible price movement of a trading instrument. For example, in 
futures markets, a tick may represent a fraction of a point, depending on the instrument. 

 LevelTicks: The number of ticks between each grid level. This defines how far apart buy and 
sell orders are placed. 

 TicksToSkip: The number of ticks skipped between grid levels, determining how tightly or 
loosely grid orders are placed. 

 MaxEntries: The maximum number of grid levels or active orders the strategy can have at 
any given time. 

 StartPrice: The price at which the grid starts placing orders. This is the initial reference 
point for the grid structure. 

 UpperLimit/LowerLimit: Price boundaries beyond which the grid will stop executing new 
trades. These limits prevent the grid from overtrading in extreme market conditions. 

 TrailingEntries: A feature that adjusts the grid's entry points to follow market movements, 
particularly useful in trending markets. 

 TrailingTargets: A feature that adjusts the take-profit levels of active trades as the market 
moves, allowing traders to maximize profits in trending conditions. 

 ProfitShutoƯ: A parameter that stops the grid from placing new trades after a predefined 
profit target is reached. 

 LossShutoƯ: A parameter that stops the grid from placing new trades once a certain loss 
limit has been hit, helping to manage risk. 

 Sim101 Account: A simulated trading account in NinjaTrader that allows users to test 
strategies without risking real money. 

 API: Application Programming Interface, a set of functions and protocols that allows the 
Grid Master to communicate with NinjaTrader and execute programmatic commands. 
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Appendix B: NinjaTrader Shortcuts and Tips 
 Opening Grid Master: Navigate to the NinjaTrader control center and select New > Grid 

Master 200 to launch the bot. 

 Importing Scripts: To import a script into NinjaTrader, go to Tools > Import > NinjaScript 
Add-On, and select the ZIP file containing the bot. 

 Accessing Logs: View logs of grid operations, errors, or other important events in the 
NinjaTrader Log window, located under New > Log in the control center. 

 Backtesting: Use the Strategy Analyzer to backtest grid configurations. Right-click the 
instrument in NinjaTrader, select Strategy Analyzer, and configure your grid settings for 
testing against historical data. 

 Enabling/Disabling a Grid: Grids can be enabled or disabled using the GridMaster200 API. 
For example, use GridMaster200.Enable() to activate a grid, or 
GridMaster200.CloseAndDisable() to shut down a grid and close all positions. 

 Real-Time Adjustments: Parameters like LevelTicks, TradeSize, and Upper/Lower Limits 
can be adjusted in real-time through the GridMaster200 API. 

 

Appendix C: Best Practices for Grid Trading 
1. Start with Simulated Trading: Always test your grid in NinjaTrader’s Sim101 account before 

using real money. This allows you to refine your parameters and ensure that your strategy 
behaves as expected. 

2. Use Conservative Limits: Setting clear UpperLimit and LowerLimit boundaries helps avoid 
overexposure in unpredictable markets. Tight limits can help in highly volatile markets, 
while wider limits may work better in stable, range-bound markets. 

3. Monitor for Volatility: In volatile markets, consider increasing LevelTicks and reducing 
MaxEntries to avoid over-trading. Adjusting these parameters will allow the grid to capture 
bigger moves while reducing the frequency of trades. 

4. Enable Profit and Loss ShutoƯ: Utilize ProfitShutoƯ and LossShutoƯ to manage risk 
eƯectively. These limits ensure that you lock in profits and stop further losses once a certain 
threshold is met, helping protect your capital. 

5. Optimize with Backtesting: Regularly backtest your grid setups with NinjaTrader’s Strategy 
Analyzer to ensure that your configurations are performing well under various market 
conditions. Use historical data to fine-tune parameters like TradeSize, LevelTicks, and 
MaxEntries. 

6. Adapt to Market Trends: Markets can change from ranging to trending, and vice versa. Use 
TrailingEntries and TrailingTargets in trending markets, but avoid them in range-bound 
conditions to prevent unnecessary adjustments to your grid. 
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Appendix D: References and Resources 
 NinjaTrader Documentation: https://ninjatrader.com/Help-Connection-Guides 

 NinjaScript API: https://ninjatrader.com/support/helpGuides/nt8/ 

 Grid Trading Strategy Overview: https://www.investopedia.com/terms/g/grid-trading.asp 

 Backtesting Best Practices: 
https://ninjatrader.com/support/helpGuides/nt8/backtest_a_strategy.htm 

 Volatility and Risk Management: https://www.cmegroup.com/trading/volatility.html 

 

 


